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ABSTRACT 
Drink and drive has become a main cause of road accidents in the 
modern world. It has been found that more than 62% of road 
accidents are caused due to drink and drive. Drunk driving not only 
puts the person who has drowned at risk but also the person sitting in 
the same car with him and the people on the road, and also causing 
many deaths due to avoiding the use of seatbelts. Therefore, this 
growing threat should be given immediate attention. 

The aim of our project is to build a system that can take care of this 
hazard, a system that can sense the alcohol in the driver's breath and 
ensure proper use of seatbelts and preventive measures shall be taken. 
As if there are many laws to penalize such drivers but it cannot be 
implemented on a large scale as the police cannot check drunk 
drivers on every road. Perhaps this is the main reason for the 
accidents. Therefore, there is an urgent need for a system that can 
check drunk drivers and reduce further threats. Deaths due to drunk 
driving and not wearing seatbelts are increasing day by day which 
raises a question that who can reduce the increasing number of these 
cases? The system is a best way to find out drunken people and also 
proper usage of seatbelt. The system will basically comprise of a 
breath analyzing sensor, MQ-3, which will sense the level of alcohol 
in drivers breath. In India, the quality legal limit of alcohol in blood 
is 0.03% that means 30 micro litters of alcohol in 100 milliliters of 
blood and IR Sensor will near seatbelt retractor will ensure proper 
use of seatbelt, If the alcohol content in drivers breath is above this 
threshold limit and seatbelt is not used properly then the engine will 
not start and the person will not be able to drive. Thus, by using such 
system, we can reduce car accidents and deaths. This project can help 
prevent life and property loss because of drunk driving and deaths 
due to avoiding seatbelt. 
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1. INTRODUCTION 
The idea of developing an accident prevention system 
came in the mind of many researchers after reviewing 
the daily newspaper articles on the increasing number 
of road accidents and deaths. These accidents mainly 
occur due to increased number of vehicles, alcohol 
consumption, violation of rules and carelessness of 
driver and deaths due to avoiding seatbelts. There are 
many reasons for road accidents and deaths but in this 
project the main cause which is addressed is alcohol  
 

 
consumption and avoiding use of seatbelt by drivers. 
If this issue is addressed, road accidents and deaths 
can be reduced to a larger extent. Alcohol Level  
Detection System in cars for Driver’s Security is an 
initiative to reduce the number of accidents due to 
drink and drive and also ensuring proper usage of 
seatbelt hence will safeguarding the lives of the driver 
as well as the people inside the car and people on 
road. It is an automated and most importantly, an 
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intelligent system which will help the people as well 
as the environment. 

A temperature sensor measures the temperature of the 
breath sample to ensure that it is the same 
temperature as human breath. A sensor is used for a 
specific volume of the breath sample, which is used to 
determine the alcohol content. A Microcontroller is 
used to convert the output into a reading which 
represents the breath alcohol content of the breath 
sample. This analysis is used as part of an overall 
automobile ignition locking system which prohibits 
starting the car when the operator is intoxicating. The 
system also requires rolling retests to ensure that the 
driver is still sober 

Drunk driver can be prevented from starting a car at 
initial stage itself by using a simple alcohol sensor. 
This will mandate the driver to blow into a device 
which collects breath sample of the driver to process 
further to determine the output signal. The car alcohol 
sensing device will have a threshold to allow the 
driver to start the car. The driver can start car only 
when he consumes alcohol lower than the threshold 
level. Ignition interlock systems which meets federal 
standards requires test on engine start and also require 
a test every few minutes while driving is called as 
rerolling test. This is going to be a simple fool proof 
system which does not allow a drunk driver to start 
his car, until his alcohol consumption level goes 
below the threshold. Threshold should be adjustable, 
in case government changes the permissible level, 
ultimately threshold could also be changed. While the 
traditional use of the breath analyzing devices has 
been by law enforcement officers to test a suspected 
intoxicated driver, the breath analyzing devices now 
are being used in combination with an ignition 
locking system to prevent an intoxicated driver from 
being able to start the vehicle 

2. LITERETURE REVIEW 
2.1. INTRODUCTION 
It is known that alcohol use affects driving skills and 
increases accident risk. It has been found that while 
driving under the consumption of alcohol, the risk of 
having an accident causing injury and death increases. 
Drink and drive has a high probability to cause 
serious accidents. Even with a small amount of 
alcohol consumption, driver is is likely to be involved 
in traffic accidents than the sober drivers. Therefore, 
many countries are working on solutions to drink and 
drive accidents for a longer period of time, including 
publicity and education and tough drunk-driving 
laws. The laws have been enacted to reduce driving 
after drinking and have imposed severe .Seatbelt is 
one of the most efficient feature in a vehicle which is 
used to reduce the injury to the vehicle passengers in 

cars that results from road accidents. Failure to use a 
seat-belt is a major risk factor for road traffic deaths 
and injury among vehicle occupants. Passengers who 
do not wear seatbelts and have a front crash are most 
likely to suffer a head injury. 

2.2. REVIEW OF LITERATURE 
2.2.1. “Alcohol Detection in Real-Time To 

Prevent Drink Drive” [1] 
In this paper, a liquor level identification framework 
is introduced alongside its upsides and downsides. It 
features the expanding number of mishaps because of 
rash and indiscreet driving; it advances the utilization 
of this framework to limit cases like these. A MQ-3 
liquor sensor alongside the microcontroller 
Atmega328 will distinguish the driver's breath liquor 
content. A portion of the situations are recorded as 
underneath:  
1. At the point when the driver enters the vehicle in 

drunk state: In such a case, the sensor will 
identify the liquor level when the driver enter 
inside and the vehicle won't begin. 

2. At the point when the driver takes liquor after the 
vehicle is begins or while driving. The 
Framework is planned so that it will keep on 
running during the whole course of driving and 
will continue to check the liquor content 
persistently  

3. In case Passengers are drinking liquor while the 
vehicle is on running however not the driver: In 
such a case, it will not recognize since the 
framework is introduced on the directing wheel. 

2.2.2. “Crash Risk of Alcohol Involved Driving: 
A Case-Control Study” [2] 

Drive under the influence of alcohol perceived as the 
fundamental driver of traffic wellbeing in the mid 
20th century it actually keeps on being a primary 
street security issue. The contextual analysis 
examined the mishap risks related with driver's blood 
liquor utilization. The acquired worth, is portrayed as 
the proportion 9 of extent of degree of crash drivers to 
the degree of, control drivers in a BAC gathering, 
contrasted with a comparably shaped extent of drivers 
with zero percent BACs.  

2.2.3. “Vital Signs: Alcohol-Impaired Driving 
Among Adults” [3] 

Approximately 1/4 of all the vehicles, crash accidents 
cause due to drunk driving. In 2009, 10, 909 people 
died in accidents in which at least one driver had 
blood alcohol consumption greater than 0.08 g/dL. 
Rates of self-revealed alcoholic driving have declined 
in the past years. However, still the rates is been high 
among the youths.  
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To reduce this drink and driving cases, states and 
countries have increased alcohol taxes, directing 
alcohol outlet density, and enacting on these laws 
strictly. States without seat belt laws ought to 
consider enacting on them to help lessen fatalities due 
to drunk driving 

2.2.4. “IOT-ENABLED ALCOHOL 
DETECTION SYSTEM FOR ROAD 
TRANSPORTATION SAFETY IN 
SMART CITY” [4] 

In this paper, an alcohol level detection system was 
invented for road safety in smart cities using Internet 
of Things (IoT) technology. The system not only 
checks alcohol impaired driving by automatically 
locking down the car which the drunk person is 
Operating but even enables the traffic experts to 
effectively discover the shutdown  

Vehicles utilizing the coordinates of the vehicle by 
sending it to a web server. The advancements which 
are implanted in this framework are adequate to 
guarantee the shut down and furthermore a pick-up of 
the driver of the vehicle through the location sent by 
means of message or mail. 

2.2.5. “Drunk-Driver Detection and Alert System 
(DDDAS) for Smart Vehicles”[5] 

This paper talks about plan, live execution trial of 
drive under the influence recognizable proof and 
ready cum vehicle control model to lessen street 
mishaps because of driving drunk. The basic piece of 
the framework configuration is variety in separation 
from the source. The point is to make the vehicle 
adequately shrewd to Discover the alcoholic 
condition of the driver and make preventive moves 
before any disaster occurs on street. In light of late 
keen gas detecting and combination of satellites and 
versatile remote correspondences advances, the 
framework detects the alcoholic state and on-vehicle 
sound alert is gone on to caution individuals on street 
and vehicle control framework is set off to lock the 
start or stop fuel inflow to the vehicle. Also with the 
assistance of GPS and GSM cell organization, area is 
shipped off family, companion or police. 

2.2.6. “Novel drunken driving detection and 
prevention models using Internet of 
things”[6] 

Drink drive is one of the major causes behind 
majority of the deaths in the today’s world. In this 
paper, Novel based IOT module is proposed to save 
the individuals from deaths caused by road accidents 
due to drunk driving. The Proposed framework uses 
Internet of things tech. device as Raspberry Pi 3 
model B as a core. It mostly includes alcohol 
concentration detection sensor, Touch sensor, Heart 
beat rate, Facial recognition, eye detection system, 

etc. to safeguard the tipsy driver. Different sorts of 
securing things, for instance, Triggering an alert GPS 
module and Automatic get going, etc are used. 

2.3. Identification of Gaps 
 There is no system present that can ensure proper 

usage of seatbelt by the driver.  

 There are many advanced system installed in the 
vehicles which can check the performance of the 
vehicles but this system is different from those as 
it checks the drivers state while he is driving the 
vehicle.  

 Alcohol detection techniques which are used 
presently like handheld sensors, skin sensors, are 
contact based or need person’s participation.  

 Some of this existing system does not maintain 
the feature of early alert and auto shut down of 
vehicle. 

2.4. Problem statement 
 Most of the road accidents are occurred due to 

drink and drive. It is a major problem in India but 
due to lack of research and measures this problem 
still exists.  

 A report by Alcohol and Drugs Information 
Centre (AIDC) revealed that about 35% of road 
accidents in India caused due to driving under the 
influence of alcohol consumption.  

 Failure to use a seatbelt is a main risk factor for 
road accident deaths and injuries among vehicle 
passengers.  

 Passengers who do not wear seatbelts and have a 
front crash are most likely to suffer by head 
injury. 

2.5. OBJECTIVE 
 To build a reliable and cost effective system to 

reduce the accidents and to safeguard human life. 
 To Explore and examine the appropriate software 

and hardware required to implement the system. 
 To manufacture a prototype of accident 

prevention system that can eliminate the danger. 
 Test the performance of the implemented system 

to achieve the desired outcome for safe transport 
system 

2.6. Scope of work  
 This accident prevention system using alcohol 

sensor that can detect the driver’s alcohol 
consumption which is the main cause of 
accidents.  

 By Using IR sensor near seatbelt retractor which 
can be use to ensure proper use seatbelt.  

 Can help driver to prevent road accidents before 
by alerting them and automatically shutting down 
the vehicle if alcohol is detected. 
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3. METHODOLOGY 
The system consists of three main steps. Firstly, to 
check whether driver has used seatbelt then to check 
the driver’s breath whether he is drunk or not and 
pass the decision made on the basis of this 
measurement and lastly ensure alcohol consumption 
and use of seatbelt to start the vehicle. 

3.1. Methodology details 
1. The driver sits inside the car and uses the seatbelt 

calibrated patch of belt will be coloured black so 
the IR sensor near reactor will detect the patch. 

2. Then it will send signal via Arduino to 
microcontroller to instruct the ignition system. 

3. Ensuring that he has properly used the seatbelt. 

4. If the driver is drunk then the sensor placed on the 
steering wheel will detect his breath and send the 
output which is converted to digital through 
arduino and the output is then sent to the 
microcontroller.  

5. If the output reading is more than a certain set 
threshold, then driver has consumed alcohol 
above limit and he is declared drunk.  

6. If the output is more than the threshold, then the 
driver is heavily drunk and if he does not use 
seatbelt then the car engine won’t start. 

7. If the person starts drinking while driving, the 
sensor will again sense his breath and stop the 
vehicle. 

8. If alcohol is not detected during the whole drive, 
the car will run smoothly. 

3.2 Coding for Both the Circuits 

 
Fig.3.1 CODING FOR MQ-3 ALCOHOL 

SENSOR 

 

 
Fig.3.2 CODING FOR IR SENSOR 

a. Instrumentation 

 
Fig.3.3 Design of Prototype 

 
The CAD Design of the project prototype is as seen 
above. The frame is manufactured according to the 
design and the design is made by considering the 
actual dimensions and position of driver inside the 
automobile. 

The Sensors are placed according to the requirement 
and the front desk is used to illustrate as an dashboard 
where the circuits are kept the alcohol sensor is 
mounted on the centre of the steering wheel which is 
used to detect the alcohol value and the irsensor is 
placed near the retractor of the seat belt which is used 
to detect the seat belt proper usage. 

The MQ3 sensor receives the data from the cabin and 
then sends it to the Arduinonano sensor and the data 
is processed if the data is within the set value the 
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ignition system will work otherwise the ignition 
system will not start when the alcohol value crosses 
the set value the motor stops and the buzzer starts 
buzzing and also the led stops glowing which 
represents the ignition system is off due to more 
alcohol value and it is demonstrated by an dc motor 
same with the IR sensor if the seat belt is not used 
properly then it will not allow the working of ignition 
system. 

4. COMPONENT DESCRIPTION 
4.1. MQ-3 ALCOHOL DETECOR SENSOR 
The MQ-3 is a cost effective sensor that is used to 
detect the alcohol gases in a person’s breath, from 
0.05 mg/L up to 10 mg/L concentrations. SnO2 (Tin 
dioxide)material is used for sensing, which has low 
conductivity in clean air and the conductivity 
increments with the concentration of alcohol gases 
present in breath. MQ3 sensor is highly sensitive to 
alcohol and has a few resistance to disturbance caused 
due to gasoline, vapour and smoke. It provides both 
analog and digital outputs. It can be effectively 
interfaced with Microcontrollers, Arduino Boards, 
Raspberry Pi, and so on.  

The alcohol sensor detects the alcohol in a person’s 
breath, like a common breath analyzer. The circuit is 
quite simple in construction and all it needs is a 
resistor. Sensor has 4 pins but we use 3 the other two 
are used for power ground and input. This sensor has 
a heating framework inside which is made up of tin 
dioxide, aluminum oxide. It has heat coils are used to 
produce heat, and it is used as a heat sensor module. 

 
Fig4.1 MQ-3 ALCOHOL SENSOR 

The alcohol sensor used here is the MQ-3 sensor. 
MQ-3 sensor is not only sensitive to alcohol, but also 
sensitive to ethanol, which is one type of alcohol 
found in wine, beer, and liquor. MQ-3sensor circuit 
can be used as a breath analyzer to check a person's 
blood alcohol level. Just as we exhale carbon dioxide 
when we breathe out, we also breathe out some 
alcohol if we have alcohol in our blood. Any 

alcometer device can measure this alcohol content. 
The more ethanol in your blood, the more there is in 
the air on exhalation. This alcohol content gives an 
indication for if a person is drunk and how much 
percent drunk they are. The amount of alcohol 
exhaled into the air is proportionate to the amount of 
alcohol which will be found in a individual’s blood. 
Alcometers use an in-built formula to guesstimate 
blood alcohol content from exhaled air alcohol 
content. 

4.1.1. Working Principle 
The framework is cubical shape. An Alumina tube 
covered by SnO2 (tin dioxide) and between them, 
there is a Gold (Au) anode. At the point when liquor 
particles in air come into contact with the cathode, for 
example between tin dioxide and alumina, a 
compound response happens in which acidic 
corrosive is framed by consuming of ethanol and 
afterward more current produces and based on that 
current it decides the liquor even out and create the 
simple yield. 

4.1.2. Features: 
 Highly sensitive to alcohol 
 Has long life 
 Has fast response 
 Simple circuit 
 Easily available and cheap 

4.1.3. Technical Specifications: 
 Gas Detected: Alcohol 
 Concentration: 0.4mg/L – 4mg/L 
 Supply Voltage: <25V 
 Heater Voltage: 5.0V ± 0.2V (H.igh), 1.6V ± 

0.1V (Low) 
 Load Resistance: Adjustable 
 Heater Resistance: 30Ω ± 3Ω 
 Heater Consumption: <900Mw 

4.2. ARDUINO BOARD 
Arduino is open source platform which is mostly used 
for building projects. It contains both software and 
hardware that runs on computers. From smallest 
things like robots to automation systems, Arduino can 
be used everywhere to make everyday life easier. 
Arduino board is a microcontroller. It has 14 digital 
pins(out of which 6 can be used as PWM outputs) and 
6 analog pins, the microcontroller or the main chip 
that allows us to program the Arduino so that it can 
take commands and execute accordingly, USB port 
which issued communicate with computer and also 
used to powered the Arduino, reset button, power jack 
and more. It contains everything expected to help the 
microcontroller 
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Fig.4.2 ARDUINO BOARD 

It is also proficient of receiving and sending 
information over the web with the help of various 
Arduino shields. Arduino uses a hardware known as 
the Arduino development board and software for 
developing the code known as the Arduino IDE 
(Integrated Development Environment). Built up with 
the 8-bit Atmel AVR microcontroller's that are 
manufactured by Atmel or a 32-bit Atmel ARM, 
these microcontrollers can be programmed simply 
using the C or C++ language in the Arduino IDE 

4.2.1. FEATURES: 
 Microcontroller: ATmega328 
 Operating Voltage: 4V 
 Input Voltage: 8-13V 
 Digital I/O Pins: 14 
 Analog Input Pins: 6 
 DC Current per I/O Pin: 40 mA 
 DC Current for 3.3V Pin: 50 mA 
 Flash Memory: 31 KB (ATmega328) 
 SRAM: 2 KB (ATmega328) 
 EEPROM: 1 KB (ATmega328) 
 Clock Speed: 15 MHz 

4.3. IR SENSOR 
This Infrared object detection sensor is easy to use. It 
comes with on board potentiometer to adjust the 
sensitivity. The output is digital signal so it is easy to 
interface with any microcontroller such as Mega, 
Zero, 101, Arduino UNO even the Raspberry Pi This 
IR sensor offers simple, fast and user friendly 
obstacle detection via IR reflection, it is non-contact 
detection. It is based on light reflection, the detection 
can vary with different surface. And any infrared 
source might also interfere the detection it comes in a 
pair of Infrared emitter and receiver at the front of 
module, whenever there is object blocking the 
infrared source, it reflects the infrared and the 
receiver get it and the signal go through a comparator 
circuit on board. And depending on the threshold that 

being adjusted, it will output logic low at output pin 
and the green LED will light up to indicate the 
detection 

 
Fig.4.3 IR SENSOR 

4.4. DC MOTOR 
A DC Motor converts electrical energy into 
mechanical energy. It works on the rule of 
electromagnetism that is the point at which a current 
conveying conductor is set in an attractive field, it 
encounters a power which makes it pivot. The 
armature curl and the stator are the two fundamental 
pieces of DC engine. The armature is the turning part 
though the stator is the fixed part. The armature curl 
is associated with DC supply. It comprises of 
reporters and brushes. The observer changes over the 
AC current initiated in the armature into DC current. 
The brushes move the current from the pivoting part 
to the fixed outside load. The armature is put between 
the north pole and south pole of the lasting or 
electromagnets. At the point when DC supply is given 
to the armature, current beginnings moving through 
it. This current fosters its own field around the loop. 
By the communication of fields, resultant field is 
created across the conductor. The resultant field 
recaptures its unique position. The field applies power 
around the finish of the conductor and the loop begins 
turning 

 
Fig.4.4 DC MOTOR 

The working principle of DC (Direct Current) motor 
is, when a conductor, is placed in a magnetic field, it 
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experiences a torque and has a propensity to move. 
This is known as motoring action. If the path of 
current in the wire is inverted, the way of spin also 
reverses. When magnetic field and electric field 

interact, they produce a mechanical force, and based 
on that the working principle of DC motor 
established. The direction of rotation of DC motor is 
as defined by Fleming’s left hand rule. 

4.5. DESIGNED STRUCTURE 

 
Fig 4.5 MQ-3 ALCOHOL SENSOR CIRCUIT SCHEMATIC 

Here we propose a system where the person is detected for alcohol level in his body to avoid accidents. drivers 
will be sensed before they start their vehicle. Driver will be sensed by an sensor once he sited on the driver seat 
by his breath. sensor is placed in the steering to monitor the breath level if the alcohol content in breath is 0.08% 
then car engine will not ignite. in this system if the driver is not drunk he can drive otherwise he can’t drive until 
the alcohol content decreases. 

This is the structure where the sensor is placed in the steering. it will sense the driver’s alcohol content in his 
breath. 

Arduino is configured and connected with the sensor also LCD display and one dc motor is connected. Once the 
connection is given power supply is given to it so that the motor will start running. Now alcohol is sprayed in it 
where the alcohol content is above 0.08% so the LCD display will show that alcohol content is overflow, dc 
motor will stop running and ignition also stopped.  

This process is implemented same in all vehicle where the car engine will be connected to the sensor. Once the 
sensor sensed its output will be sent to the motor by referring the range engine will stop its execution While 
implementing this proposed system we can reduce the accidents by 75% and reduce the loss of property and 
lives. 

4.6. Connecting DC Motor with Microcontroller 
Motors cannot be driven directly through microcontroller. We use these motor drivers as an interfacing device 
between motors and microcontrollers. Motor drivers take a low current control signal and provide a high current 
signal which is used to drive the motors hence they act as current amplifiers. Using L293D chip is a simple way 
to control the motor using a microcontroller. The internal circuit has two H-bridge driver circuits. This chip is so 
designed as how to control the two motors. L293D has two sets of arrangements where one set has input 1, input 
2, output1, output 2, with enable pin. Whereas, the other set has input 3, input 4, output 3, output 4 with another 
enable pin 
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Fig.4.6 CONNECTING DC MOTOR WITH MICROCONTROLLER 

4.7. Features Of Alcohol detector 
 It has sensible sensitivity to alcohol in wide selection, and has benefits like long period of time, low value 

and easy drive circuit &amp; etc.  

 Touch water Sensitivity of the sensors are going to be reduced once spattered or swaybacked in water.  

 Freezing Do avoid icing on sensor’s surface, otherwise sensing material are going to be broken and lost 
sensitivity.  

 Applied voltage on detector mustn't be over stipulated worth, though the detector isn't physically broken or 
broken, it causes down-line or heater broken, and produce on sensors’ sensitivity characteristic modified 
badly. 

 Voltage on wrong pins for six pins detector, Pin 2&amp;5 is heating electrodes, Pin (1,3)/(4,6) area unit 
testing electrodes (Pin one connects with Pin three, whereas Pin four connects with Pin 6).If apply voltage on 
Pin 1&amp;3 or 4&amp;6, it'll build lead broken; and no signal out if apply on pins 2&amp;4 

4.8. Circuit Diagram of Alcohol Detection 

 
Fig 4.7 ALCOHOL DETECTION CIRCUIT DIAGRAM 

4.9. Circuits Diagram of IR Sensor 
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Fig.4.8 IR SENSOR CIRCUIT DIAGRAM 

5. SOFTWARE DESCRIPTION 
The Arduino Integrated Development Environment - 
or Arduino Software (IDE) – use text editor for 
writing code, a text console, a toolbar, a message 
region with catches for normal capacities and a 
progression of menus. It interfaces with the Arduino 
and Genuino equipment to transfer programs and 
speak with them. 

Writing Sketches 
Projects composed utilizing Arduino Software are 
called as portrayals. These representations are written 
in the word processor and are saved with the record 
expansion. The supervisor has highlights for 
reordering and for supplanting text. The message 
region gives criticism while saving and sending out 
and furthermore shows blunders. The control center is 
utilized to shows text yield by the Arduino Software 
including total mistake messages and other data. The 
base right hand corner of the window shows the 
arranged board and sequential port. The toolbar 
catches is utilized and permits us to check and 
transfer programs, make, open, and save outlines, and 
open the chronic screen. 

Extra orders are found inside the five menus: File, 
Edit, Help Sketch, Tools, and. The menus are setting 
delicate, which implies just those things applicable to 
the work as of now being 

Sketchbook 
The Arduino Software uses the concept of a 
sketchbook: a standard place to store your programs 
(or sketches). The sketches in your sketchbook can be 
opened from the File > Sketchbook menu or from the 
Open button on the toolbar. The first time you run the 
Arduino software, it will automatically create a 
directory for your sketchbook. You can view or 
change the location of the sketchbook location from 
with the Preferences dialog. 

Beginning with version 1.0, files are saved with a .ino 
file extension. Previous versions use the. pde 
extension. You may still open. pde named files in 
version 1.0 and later, the software will automatically 
rename the extension to .ion. Tabs, Multiple Allows 
you to manage sketches with more than one file (each 
of which appears in its own tab). These can be normal 
Arduino code files (no visible extension), C files (.c 
extension), C++ files (.cpp), or header files (.h). 

Uploading 
Prior to transferring your sketch, you need to choose 
the right things from the Tools > Board and Tools > 
Port menus. The sheets are portrayed underneath. On 
the Mac, the sequential port is presumably something 
like/dev/tty.usbmodem241 (for an Uno or Mega2560 
or Leonardo) or/dev/tty.usbserial-1B1 (for a 
Duemilanove or prior USB board), 
or/dev/tty.USA19QW1b1P1.1 (for a sequential board 
associated with a Key span USB-to-Serial connector). 
On Windows, it's likely COM1 or COM2 (for a 
sequential board) or COM4, COM5, COM7, or higher 
(for a USB board) – to discover, you search for USB 
sequential gadget in the ports part of the Windows 

Device Manager. On Linux, it ought to 
be/dev/ttyACMx,/dev/ttyUSBx or comparative. 
Whenever you've chosen the right sequential port and 
board, press the transfer button in the toolbar or select 
the Upload thing from the Sketch menu. Current 
Arduino sheets will reset naturally and start the 
transfer. With more seasoned sheets (pre-Decimal) 
that need auto-reset, you'll need to press the reset 
button on the board not long prior to beginning the 
transfer. On most sheets, you'll see the RX and TX 
LEDs squint as the sketch is transferred. The Arduino 
Software (IDE) will show a message when the 
transfer is finished, or show a blunder. 
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Third-Party Hardware 
Support for third-party hardware can be added to the 
equipment catalog of your sketchbook registry. 
Stages introduced there may incorporate board 
definitions (which show up in the board menu), center 
libraries, boot loaders, and developer definitions. To 
introduce, make the equipment registry, then, at that 
point unfasten the outsider stage into its own sub-
index. (Try not to utilize "arduino" as the sub-catalog 
name or you'll supersede the inherent Arduino stage.) 
To uninstall, essentially erase its index. For details on 
creating packages for third-party hardware, see the 
Arduino IDE 1.5 3rd party Hardware specification. 

Serial Monitor 
This displays serial sent from the Arduino or Genuino 
board over USB or chronic connector. To send 
information to the board, enter text and snap on the 
"send" catch or press enter. Pick the baud rate starting 
from the drop menu that coordinates with the rate 
passed to Serial. Start in your sketch. Note that on 
Windows, Mac or Linux the board will reset (it will 
rerun your sketch) when you interface with the 
chronic screen. If it's not too much trouble, note that 
the Serial Monitor doesn't handle control characters; 
if your sketch needs a total administration of the 
sequential correspondence with control characters, 
you can utilize an outside terminal program and 
associate it to the COM port allotted to your Arduino 
board. You can also talk to the board from 
Processing, Flash, MaxMSP, etc (see the interfacing 
page for details) 

Language Support 
Since structure 1.0.1, the Arduino Software (IDE) has 
been changed over into 30+ different vernaculars. 
Obviously, the IDE loads in the language picked by 
your functioning system. (Note: on Windows and 
possibly Linux, this is constrained by the region 

setting which controls cash and date plans, not by the 
language the functioning system is displayed in.) 

On the off chance that you might want to change the 
language physically, start the Arduino Software (IDE) 
and open the Preferences window. Close to the Editor 
Language there is a dropdown menu of presently 
upheld dialects. Select your favored language from 
the menu, and restart the product to utilize the chose 
language. On the off chance that your working 
framework language isn't upheld, the Arduino 
Software will default to English. You can return the 
software to its default setting of choosing its language 
dependent on your working framework by choosing 
System Default from the Editor Language drop-down. 
This setting will produce results when you restart the 
Arduino Software (IDE). Likewise, subsequent to 
changing your working framework's settings, you 
should restart the Arduino Software (IDE) to refresh 
it to the new default language. 

Boards 
The board choice has two impacts: it sets the 
boundaries (e.g., CPU speed and baudrate) utilized 
when aggregating and transferring representations; 
and sets and the document and breaker settings 
utilized by the consume boot loader order. A portion 
of the board definitions vary just in the last 
mentioned, so regardless of whether you've been 
transferring effectively with a specific choice you'll 
need to check it prior to consuming the boot loader. 
You can discover a correlation table between the 
different sheets here. 

Arduino Software remembers the help for the sheets 
for the accompanying rundown, all dependent on the 
AVR Core. The Boards Manager remembered for the 
standard establishment permits adding support for the 
developing number of new board dependent on 
various centers like Edison, Arduino Zero, Galileo, 
Arduino Due, etc. 

6. RESULTS 
We know that the flow of our system depends on whether the driver is drunk or not and he has wear the seatbelt 
properly, So therefore, if driver is not drunk and use seat belt properly the DC motor will keep rotating. The 
driver sits inside the car and uses the seatbelt calibrated patch of belt will be colored black so the IR sensor near 
retractor will detect the patch and if the value goes above 1000 it means the black patch is detected and driver 
has n used seatbelt properly and LED gets on and if value remains between 15 to 50 it means he has not used 
seatbelt and motor start rotating. 
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After conforming the proper use of seatbelt, if the driver is drunk then the sensor placed on the steering wheel 
will detect his breath and value goes above 800 the buzzer will beep and motor will stop rotating 

 

 
Fig. 6.1 CODING FOR ALCOHOL SENSOR 

7. LIMITATIONS 
 If the driver is wearing a mask or his mouth is 

covered by any means, the measure of alcohol 
consumption in breath will be less to trigger 
sensor. 

 If the driver has covered the MQ3 sensor by any 
means it won’t work appropriately. 

 If windows of car are open the sensor won't 
distinguish whether the driver is drunk or not as 
the gases and the air currents will not allow the 
sensor to function accurately and if he is drunk 
the accurate alcohol concentration won’t be 
detected. 

 

 

 

8. FUTURE SCOPE 
 This can be used in every vehicle as a safety 

measure. 
 Use of GPS tracking system to locate the position 

of car. 
 This location can be further forwarded to inform 

driver’s friend or relative after alcohol detection 
is more than the permitted limit. 

 Email or SMS can be sent to driver’s friend or 
relative after more alcohol detection to pick them 
from their current location. 

 The alcohol detection with engine locking system 
prove automatic safety system for cars and other 
vehicles 

 

 



International Journal of Trend in Scientific Research and Development @ www.ijtsrd.com eISSN: 2456-6470 

@ IJTSRD   |   Unique Paper ID – IJTSRD50121   |   Volume – 6   |   Issue – 4   |   May-June 2022 Page 770 

9. CONCLUSION 
 This system can help to prevent drink and drive 

cases to a much larger extent as well as protect 
and safeguard the lives of innocent people from 
getting harmed due to this drink and drive on 
road. 

 This system will ensure Compulsion of wearing 
seatbelts which will assure safety of driver. 

 This Safety system can be installed in vehicles to 
prevent road accidents and deaths due to avoiding 
the use of seatbelts. 

 If this system is implemented in automobile, the 
accidents due to drink and drive can be reduce 
down to a minimum level and also will save life 
by assuring use of seatbelts. 

 If accident is detected then it shares the accident 
location to the emergency services using GSM 
and GPS. But, when vehicle is still moving even 
after alcohol detection then the location of the 
vehicle is sent to concerned authorized services. If 
accident is detected then it shares the accident 
location to the emergency services using GSM 
and GPS. But, when vehicle is still moving even 
after alcohol detection then the location of the 
vehicle is sent to concerned authorized services. 

9.1. COST ESTIMATION 
9.1.1. Costing of parts 

SR NO PART NAME QUANTITY COST 
01 Prototype 01 2000 
02 Seat 01 1500 
03 Steering 01 1500 
04 Seatbelt 01 2200 

TOTAL COST 7200 

9.1.2. Costing of Sensors and motor 
Sr No PART NAME QUANTITY COST 

01 Alcohol Sensor 01 150 
02 Arduino Board 01 700 
03 IR Sensor 01 50 
04 DC Motor 01 80 
 TOTAL COST  950 
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